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1 Цели освоения дисциплины (модуля)  
Цель изучения дисциплины «Геоинформационные системы» — овладение знания-

ми современных технологий, методов и средств создания и использования автоматизиро-
ванных информационных систем, ориентированных на анализ пространственных (геогра-
фических) данных в процессе поддержки принятия решений.  

В ходе изучения дисциплины решаются следующие задачи:  
Знакомство студентов с основными теоретическими принципами организации гео-

информационных систем;  
Обучение использованию новейших компьютерных геоинформационных техноло-

гий для обработки пространственно-временных данных;  
Формирование знаний и умений, необходимых для принятия обоснованных реше-

ний на всех стадиях и этапах проектирования, построения и использования автоматизиро-
ванных  

информационных систем, ориентированных на анализ пространственных (геогра-
фических) данных.  
  2 Место дисциплины (модуля) в структуре образовательной программы  

Дисциплина Геоинформацционные системы входит в часть учебного плана форми-
руемую участниками образовательных отношений образовательной программы.  

Для изучения дисциплины необходимы знания (умения, владения), сформирован-
ные в результате изучения дисциплин/ практик:  

Базы и хранилища данных  
Точные и эвристические алгоритмы  
Структуры и модели данных  
Теория и практика распределенных и параллельных вычислений  
Обработки изображений и визуальные эффекты  
Прикладная математика  
Программирование  
Знания (умения, владения), полученные при изучении данной дисциплины будут 

необходимы для изучения дисциплин/практик:  
UsaBility в сложных пользовательских интерфейсах  
Управление контентом для мобильных устройств  
Технологии Data Mining  
Выполнение и защита выпускной квалификационной работы  
Интеграция БД в мобильные приложения  

  3 Компетенции обучающегося, формируемые в результате освоения  
дисциплины (модуля) и планируемые результаты обучения  
В результате освоения дисциплины (модуля) «Геоинформацционные системы» 

обучающийся должен обладать следующими компетенциями:  
  

Код индикатора  Индикатор достижения компетенции  

ПК-6 Владеет способами разработки процедур интеграции программных модулей, компо-
нент и верификации выпусков программного продукта, включая базы данных для мобиль-
ных устройств  
ПК-6.1  Оценивает выбор программных средств для разработки и верификации 

программных модулей для мобильных устройств  
ПК-8 Владеет навыками ввода в эксплуатацию аппаратных, программно-аппаратных и 
программных средств инфокоммуникационной инфраструктуры совместно с представите-
лями поставщиков оборудования, готов к обслуживанию периферийного оборудования и 
организации инвентаризации технических средств  
ПК-8.1  Оценивает качество ввода в эксплуатацию аппаратных,  



 

 программно-аппаратных и программных средств инфокоммуникаци-
онной инфраструктуры  

ПК-8.2  Оценивает качество обслуживания периферийного оборудования и ор-
ганизацию инвентаризации технических средств  

 

 4. Структура, объём и содержание дисциплины (модуля)  
Общая трудоемкость дисциплины составляет 4 зачетных единиц 144 акад. часов, в том 
числе:  
– контактная работа – 77,6 акад. часов:  
– аудиторная – 72 акад. часов;  
– внеаудиторная – 5,6 акад. часов  
– самостоятельная работа – 30,7 акад. часов;  
– подготовка к экзамену – 35,7 акад. часа  
 
Форма аттестации - курсовой проект, экзамен  
          

Аудиторная  
контактная работа  

(в акад. часах)  Раздел/ тема  
дисциплины  
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Вид 
самостоятельной  

работы  

Форма текущего 
контроля успевае-

мости и  
промежуточной 

аттестации  

Код 
компетенции  

1. Основные понятия геоинформационных систем. Модели пространственных данных  

1.1 Геоинформатика и ее 
связь с другими науками. 
Место геоинформатики в 
системе наук. Геоматика. 
Взаимосвязи с картогра-
фией, дистанционным 
зондированием и инфор-
матикой. Определение 
ГИС. История развития 
ГИС. Классификация и 
структура ГИС. ГИС и 
Интернет  

2  2   5  

1. Подготовка к 
лабораторному 

занятию 
2. Выполнение 
лабораторной 

работы 
3. Самостоятель-

ное изучение 
учебной и науч-
ной литературы 

1. Беседа - обсуж-
дение  

2. Проверка инди-
видуальных зада-

ний  
3. Устный опрос.  

ПК-6.1, ПК-
8.1, ПК-8.2  

1.2 Модели данных для 
представления простран-
ственной информации. 
Источники данных. Ос-
новные модели простран-
ственных данных. Базы 
данных и их разновидно-
сти. Позиционные и тема-
тические характеристики 
в базах данных. Операции 
над базами данных. 
Пространственные базы 
данных. Единое 
хранилище 
пространственной 
информации.  

7  

4  4   5  

1. Подготовка к 
лабораторному 

занятию 
2. Выполнение 
лабораторной 

работы 
3. Самостоятель-

ное изучение 
учебной и науч-
ной литературы 

1. Беседа - обсуж-
дение  

2. Проверка инди-
видуальных зада-

ний  
3. Устный опрос.  

ПК-6.1, ПК-
8.1, ПК-8.2  

Итого по разделу  6  6   10     
2. Языки разметки географической информации  



2.1 Разметка документов. 
SGML как обобщенный 
метаязык структурной 
разметки любых разно-
видностей текстов. Ос-
новные конструкции язы-
ка разметки SGML. GML- 
язык разметки географи-
ческой информации как 
конкретное приложение. 
SGML. GML и KML. 
Синтаксис KML.  

7  8  8   5  

1. Подготовка к 
лабораторному 

занятию 
2. Выполнение 
лабораторной 

работы 
3. Самостоятель-

ное изучение 
учебной и науч-
ной литературы 

1. Беседа - обсуж-
дение  

2. Проверка инди-
видуальных зада-

ний  
3. Устный опрос.  

ПК-6.1, ПК-
8.1, ПК-8.2  

Итого по разделу  8  8   5     
3. Пространственновременной анализ данных  

3.1 Картометрические 
функции. Оверлейные 
операции. Расчет и по-
строение буферных зон. 
Анализ сетей. Анализ 
видимости объектов. Аг-
регирование данных. Ме-
тоды и средства визуали-
зации данных. Картогра-
фические анимации. Ос-
новы ведения территори-
альных кадастров. При-
кладные аспекты геоин-
формационных систем.  

7  8  8   5  

1. Подготовка к 
лабораторному 

занятию 
2. Выполнение 
лабораторной 

работы 
3. Самостоятель-

ное изучение 
учебной и науч-
ной литературы 

1. Беседа - обсуж-
дение  

2. Проверка инди-
видуальных зада-

ний  
3. Устный опрос.  

ПК-6.1, ПК-
8.1, ПК-8.2  

Итого по разделу  8  8   5     
4. Электронные карты  

4.1 Оцифровка исходных 
картографических мате-
риалов. Растрово-
векторные преобразова-
ния. Проекции и проек-
ционные преобразования 
в ГИС. Методы картогра-
фии. Отображение атри-
бутивных характеристик 
топографическими знака-
ми. Организация атрибу-
тивной информации. Вы-
бор объектов. Редактиро-
вание структуры и ин-
формации в базах данных  

7  8  8   5  

1. Подготовка к 
лабораторному 

занятию 
2. Выполнение 
лабораторной 

работы 
3. Самостоятель-

ное изучение 
учебной и науч-
ной литературы 

1. Беседа - обсуж-
дение  

2. Проверка инди-
видуальных зада-

ний  
3. Устный опрос.  

ПК-6.1, ПК-
8.1, ПК-8.2  

Итого по разделу  8  8   5     
5. Современные геоинформационные системы  



5.1 Примеры реализации 
ГИС. Глобальные проек-
ты. Обзор программных 
средств используемых в 
России. Отечественные 
разработки. Семейство 
геоинформационных сис-
тем ArcGIS. QGIS – гео-
информационная система 
с открытым кодом. Фор-
маты пространственных 
данных. Отображение 
данных, работа с картой.  
Работа с таблицами. Ре-
дактирование данных. 
Выполнение пространст-
венного анализа. 
Оформление карты, 
подготовка к печати.  

7  6  6   5,7  

1. Подготовка к 
лабораторному 

занятию 
2. Выполнение 
лабораторной 

работы 
3. Самостоятель-

ное изучение 
учебной и науч-
ной литературы 

1. Беседа - обсуж-
дение  

2. Проверка инди-
видуальных зада-

ний  
3. Устный опрос.  

ПК-6.1, ПК-
8.2, ПК-8.1  

Итого по разделу  6  6   5,7     
Итого за семестр  36  36   30,7   экзамен,кп   

Итого по дисциплине  36 36  30,7  курсовой проект, 
экзамен 

 
 

5 Образовательные технологии  
 1. Традиционные образовательные технологии, ориентированные на организацию 
образовательного процесса и предполагающие прямую трансляцию знаний от преподава-
теля к студенту.  

Формы учебных занятий с использованием традиционных технологий:  
Информационная лекция – последовательное изложение материала в дисципли-

нарной логике, осуществляемое преимущественно вербальными средствами (монолог 
преподавателя).  

Лабораторная работа – организация учебной работы с реальными материальными и 
информационными объектами, экспериментальная работа с аналоговыми моделями реаль-
ных объектов.  

2. Технологии проблемного обучения – организация образовательного процесса, 
которая предполагает постановку проблемных вопросов, создание учебных проблемных 
ситуаций для стимулирования активной познавательной деятельности студентов.  

Формы учебных занятий с использованием технологий проблемного обучения:  
Практическое занятие в форме практикума – организация учебной работы, направ-

ленная на решение комплексной учебно-познавательной задачи, требующей от студента 
применения как научно-теоретических знаний, так и практических навыков.  

 
6 Учебно-методическое обеспечение самостоятельной работы обучающихся  
Представлено в приложении 1.  

 7 Оценочные средства для проведения промежуточной аттестации  
Представлены в приложении 2.  

 8 Учебно-методическое и информационное обеспечение дисциплины (модуля)  
а) Основная литература:  

 1. Ловцов, Д. А. Геоинформационные системы : учебное пособие / Д. А. Ловцов, А. М. 
Черных. - Москва : РАП, 2012. - 192 с. - Текст : электронный. - URL:  
https://znanium.com/catalog/product/517128 
 (дата обращения: 28.10.2020). – Режим доступа: по подписке. 

 



 б) Дополнительная литература:  
 1. Блиновская, Я. Ю. Введение в геоинформационные системы : учеб. пособие / 

Я.Ю. Блиновская, Д.С. Задоя. — 2-е изд. — Москва : ФОРУМ : ИНФРА-М, 2019. — 112 с. 
— (Высшее образование: Бакалавриат). - ISBN 978-5-00091-115-0. - Текст : электронный. 
- URL:  

https://znanium.com/catalog/product/1029281 
 (дата обращения: 28.10.2020). – Режим доступа: по подписке. 

  в) Методические указания:  
 Представлены в приложении 2 

 г) Программное обеспечение и Интернет-ресурсы:  
     

Программное обеспечение  
 Наименование ПО  № договора  Срок действия лицензии   

 MS Office 2007 
Professional  № 135 от 17.09.2007  бессрочно   

 Kaspersky Endpoint 
Security для бизнеса-
Стандартный  

Д-300-18 от 21.03.2018  28.01.2020  

 

 КРЕДО ТОПОГРАФ 
2.1  Д-414-08 от 04.07.2008  бессрочно   

 Anaconda Python  свободно распространяемое ПО бессрочно   
 Oracle SQL Developer  свободно распространяемое ПО бессрочно   

 Oracle SQL Developer 
Data Modeler  свободно распространяемое ПО бессрочно  

 

     Профессиональные базы данных и информационные справочные системы  
 Название курса  Ссылка   
 Федеральное государственное бюджетное учреждение 

«Федеральный институт промышленной собственно-
сти»  

URL: http://www1.fips.ru/  
 

 Информационная система - Единое окно доступа к 
информационным ресурсам  URL: http://window.edu.ru/   

 Поисковая система Академия Google (Google Scholar)  URL: https://scholar.google.ru/   

 Национальная информационно-аналитическая систе-
ма – Российский индекс научного цитирования 
(РИНЦ)  

URL: 
https://elibrary.ru/project_risc.asp 

 

9 Материально-техническое обеспечение дисциплины (модуля)  
     Материально-техническое обеспечение дисциплины включает:  

 



1. Лекционная аудитория ауд. 282. Мультимедийные средства хранения, передачи и 
представления информации.  

2. Компьютерные классы Центра информационных технологий ФГБОУ ВО 
«МГТУ». Персональные компьютеры, объединенные в локальные сети с выходом в Internet, 
оснащенные современными программно-методическими комплексами для решения задач в 
области информатики и вычислительной техники.  

3. Аудитории для самостоятельной работы: компьютерные классы; читальные залы 
библиотеки. Все классы УИТ и АСУ с персональными компьютерами, выходом в Интернет 
и с доступом в электронную информационно-образовательную среду университета.  

4. Аудиторий для групповых и индивидуальных консультаций, текущего контроля и 
промежуточной аттестации. Ауд. 282 и классы УИТ и АСУ.  

5. Помещения для самостоятельной работы обучающихся, оснащенных компьютер-
ной техникой с возможностью подключения к сети «Интернет» и наличием доступа в элек-
тронную информационно-образовательную среду организации. Классы УИТ и АСУ.  

6. Помещения для хранения и профилактического обслуживания учебного оборудо-
вания. Центр информационных технологий – ауд. 372  

 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 

Приложение 1 

Учебно-методическое обеспечение самостоятельной работы обучающихся 
 

Лабораторная работа № 1 
Создание базовой карты в QGIS Desktop 

 



В данной работе студенты узнают основные  географических информационных систем, 
получат базовые навыки работы с географической информационной системой на примере 
QGIS Desktop. 

Знакомство с основными элементами интерфейса QGIS Desktop: 
— добавление слоев; 
— настройка стилей; 
— установка плагинов; 
— экспорт результата. 
 
ОБОРУДОВАНИЕ И ПРОГРАММНОЕ ОБЕСПЕЧЕНИЕ 
Для выполнения лабораторной работы требуется: 
— браузер с доступом к сети Интернет; 
— QGIS Desktop 2.16 и выше. 
 
Создание приложение QGIS Desktop.  
Для создания нового проекта откройте в основном меню вкладку Project → New или 

воспользуйтесь комбинацией клавиш Ctrl + N.  
 
Импорт данных в QGIS.  
После распаковки исходных данных (архив «Lab 1 - Materials.zip») в папке будет нахо-

диться несколько файлов, отвечающих реальным данным: дороги, здания и пр. Для того что-
бы добавить файлы в проект, достаточно «перетащить» файл с данными  route.geojson на па-
нель слоев. Кроме того, файл может быть добавлен с  помощью панели добавления слоев. Для 
добавления слоя нажмите на кнопку «Add Vector Layer» и укажите путь к папке с файлами. 

 
Создание нового поля в данных.  
Для создания нового поля воспользуйтесь окном атрибутов данных – кнопка Open 

Attribute Table. Активируйте режим редактирования с помощью кнопки Edit и откройте  каль-
кулятор полей. Создадим новое поле, которое будет отвечать за порядок соединения наших 
точек – в качестве такого поля в данном может  выступать номер строк (переменная 
row_number). Выберите данную переменную и нажмите «Ok». Убедитесь, что в таблице атри-
бутов появились новые данные. 

 
Создание нового слоя.  
Откройте окно инструментов Toolbox (View -> Panels -> Toolbox) – все дополнитель-

ные инструменты находятся в этой вкладке. Если в дальнейших работах  необходимый инст-
румент отсутствует в основном меню, воспользуйтесь поиском в панели Toolbox. В списке 
инструментов найдите функцию Points to path, выберите route.geojson в качестве входных 
данных. Установите группировку по полю OfficialGuide и порядок соединения по только что 
созданном вами полю. В результате будет создан временный слой из линий, сохраните его, 
кликнув правой кнопкой мыши по слою Paths в панели слоев. Выберите формат GeoJson, вы-
берите директорию, введите название файла и нажмите «Ok». Теперь временный слой можно 
удалить. Настало время настроить отображение получившегося маршрута. 

 
Стилизация карты. 
Для необходимо выделить слой в панели слоев. Для отключения отображения слоя не-

обходимо снять отметку в поле рядом с названием слоя. Окно Свойства слоя открывается че-
рез вспомогательное меню (отображается по клику правой кнопки мыши по названию слоя), 
либо с помощью двойного клика по названию слоя.  Выберите пункт Style в левом меню. Из-
меняя такие параметры, как цвет, толщина границы и прозрачность, можно настроить отобра-
жение по своему  усмотрению воспользуйтесь пунктом Simple fill.  

 
Добавление картографического слоя.  
Иногда экспортируемых данных недостаточно для создания полноценной карты. В та-

ком случае средствами QGIS Desktop  картографической подложкой напрямую из OSM или 
Google. Для добавления слоя необходимо выполнить следующие действия.   



1 Убедитесь, что плагин OpenLayers установлен, в противном случае установите его, 
следуя инструкции ниже. 

2 Перейдите в меню Web → OpenLayers → Название подложки. Слой с картой доба-
вится на верхний уровень. Перетаскивайте слои для изменения их порядка. 

 
Установка  плагинов  осуществляется следующим образом. 
1 Убедитесь, что QGIS разрешен доступ в Интернет.  
2 Перейдите в меню Plugins → Manage and Install Plugins. 
3 В строке поиска наберите имя требующегося плагина. 
4 Нажмите кнопку «Install». 
  
Экспорт изображения.  
QGIS Desktop позволяет экспортировать  результаты в качестве изображений в различ-

ных форматах (PNG, BMP, JPG, TIFF и т.д.). Сохраните полученный результат в одном из 
вышеперечисленных форматов. 

 
 
ВОПРОСЫ ДЛЯ ПОДГОТОВКИ 
1 Что такое карта? 
2 Что изучает наука картография? 
3 Какие способы представления данных вы знаете? 
4 Что такое геоинформационная система? 
5 Для чего применяются геоинформационные системы? 

 
Лабораторная работа № 2 

Картографические проекции 
 
В ходе данной работы студенты получат знания о системах географических координат, 

научатся преобразовывать системы координат. Получение  представления о датуме и карто-
графических проекциях; 

Знакомство с проекциями в QGIS Desktop: 
 смена проекции проекта; 
 настройка проекции слоя; 
 создание собственной проекции. 
 
Запуск существующего проекта.  
Для открытия ранее созданного  проекта запустите QGIS Desktop через основное меню 

Project → Open World View.qgs. Открыть проект можно также по двойному  клику на его фай-
ле (*.qgs), однако при этом (даже если уже запущено приложение без открытого проекта) за-
пустится  новыйпрограммы. Если проекция не задана пользователем, в качестве основной бу-
дет установлена равнопромежуточная проекция. Файл проекта содержит два  слоя с полиго-
нами Circles и Land, слой с точками Cities, а также сетку из линий Graticule. Если бы слой 
Circles отображался на изображение представляло собой идеальные круги. Однако изображе-
нии можно  наблюдать  искажения, вызванные Приложение использует параметры долготы и 
широты для измерений в геодезических десятичных градусах, которые отображаются как про-
стая прямоугольная сетка, в которой один градус долготы всегда равен одному градусы широ-
ты. Использование проекций, которые сохраняют форму,  позволит отобразить полигоны слоя 
Circles как круги. 

 
Измерение расстояний.  
Для просмотра меню систем координат  проекта в основном меню выберите Project | 

Project Properties. Затем  перейдите в раздел CRS для просмотра текущей системы координат  
(Coordinate Reference System). Нажмите Cancel для того, чтобы закрыть окно. 

Теперь необходимо измерить расстояние в текущей проекции для  последующего 
сравнения. Выберите инструмент измерения (Measure Line tool) на панели атрибутов. Откро-
ется  специальное окно.  Кликните на точку Atlanta (Атланта, США). Переместите курсор к 



точке Alice Springs (Элис Спрингс, Австралия), затем используйте правую кнопку мыши для 
завершения линии. Результат  – расстояние  между Атлантой и Элис Спрингс будет показано 
в окне измерений (Measure box). 

 
Смена системы координат проекта.  
В основном меню выберите пункт Project → Project Properties. Перейдите во вкладку 

CRS. Убедитесь, что активна опция: Enable ‘on the fly’ CRS transformation. Далее выберите  
проекцию WGS 84 / Pseudo Mercator из списка проекций (Coordinate Reference Systems). Если 
до этого момента окно измерений не было закрыто, расстояние между городами обновится 
автоматически. В противном случае повторите шаги из предыдущего пункта. 

Мировые проекции. В данной части работы студентами исследуются картографиче-
ские проекции, предназначенные для  отображения всего земного шара – проекции Эккерта 
(Eckert projection). В проекциях, содержащих в названии нечетное число, параллели размеще-
ны равномерно. В четных проекциях меридианы расположены на равном расстоянии. Три па-
ры проекции различаются заданием формы меридианов: в Эккерт I и Эккерт II меридианы 
представляют собой прямые линии, пересекающие экватор под углом; в Эккерт III и Эккерт 
IV используются эллиптические меридианы; в Эккерт V и Эккерт VI меридианы  синусои-
дальные.  Для смены проекции откройте вкладку CRS в окне свойств проекта. 

Наберите «Eckert» в строке фильтра; с использованием строки поиска  можно легко 
найти необходимую проекцию. Выберите любую проекцию  Эккерта из фильтрованного спи-
ска. Для применения выбранной проекции и переключения к окну карты воспользуйтесь 
кнопкой «OK».5. Используя инструмент измерения расстояний, вычислите дистанцию между 
Атлантой и Элис Спрингс. 

 
Национальные картографические проекции. 
Проекции, использующиеся для отображения планеты целиком,  не всегда оптимальны 

для картирования меньших областей, таких как континенты или страны. При создании карты 
в средних широтах важно использовать проекцию, которая центрируется на отображаемой 
области и имеет прямую линию или линии, проходящие через отображаемую область. 

 
Экспорт векторных данных.  
Для решения городских задач зачастую необходимо обладать базовой информацией о 

расположении  домов, границ территорий, дорог и пр. Наиболее распространенным 
Источником географических данных является сервис OpenStreetMap  (OSM).  
Существует несколько способов получения данных из OSM: 
— экспортировать данные напрямую; 
— использовать готовые наборы данных, например, MapZen1; 
— использовать сервисы с настраиваемой областью выгрузки: Trimble2, BBBike; 
— использовать встроенный плагин в QGIS. 
Trimble.  
Для изучения проекций на локальном и местном уровне  воспользуемся сервисом 

Trimble, который позволяет бесплатно выгружать определенные данные из OSM в заданном 
формате. Перейдите на главную страницу сервиса (https://data.trimble.com/market/index.html) и 
выберите раздел границы (boundaries), в списке предложенных источников выберите  
OpenStreetMap: Worldwide Boundaries. Введите в поисковой строке название города и выбери-
те в списке слоев только границы. Отрисуйте желаемую область, выберите формат данных 
ESRI Shapefile и  добавьте в корзину.Завершите оформление заказа и выгрузите данные на 
компьютер. 

 
Создание собственной системы координат.  
Очевидно, что при использовании данной проекции возникают искажения, наиболее 

заметным из которых является сдвиг. Часть проблемы заключается в том, что эта проекция 
центрирована на 0 градусах долготы. Для того чтобы это исправить, создадим специальную 
относительную систему координат, основанную на мировой проекции. Перейдите в меню на-
строек Settings | Custom CR. В данном окне  можно создать свою систему координат. Так как 
полученная система базируется на проекции Эккерта, кликните на кнопку «Copy existing CRS 



button» для открытия  списка систем координат. Выберите World_Eckert_IV из перечня недав-
но использованных проекций.  

Необходимо сдвинуть центральный меридиан к –96.000 градусам долготы вместо 
0.000. Таким образом, центр проекции окажется в  географическом центре страны. Для этого 
замените нулевой меридиан следующим значением: вместо lon_0 = 0 задайте lon_0 = −96.0. 

Параметры проекции принимают следующий вид: 
+proj = eck4 + lon_0 = −96.0 + x_0 = 0 + y_0 = 0 + datum =WGS84 + units = m + no_defs. 
В поле Name введите название проекции,  например, USA_Eckert_IV. Это имя в даль-

нейшем будет использоваться в списке проекций. Для того чтобы использовать созданную 
проекцию, перейдите в  окно проекций проекта и пролистайте до конца список Coordinate 
reference systems of the world, в конце списка будет перечень проекций, заданных  пользовате-
лем. Выберите из данного списка свою проекцию и нажмите кнопку «OK». 

 
ВОПРОСЫ ДЛЯ ПОДГОТОВКИ 
1 Что такое датум? 
2 Что такое картографическая проекция? 
3 Какие типы картографических проекций вы знаете? 
4 Назовите три наиболее известные проекции. В чем их преимущества?  
 

 
Лабораторная работа № 3 

Отображение пространственных данных 
 
ЦЕЛЬ РАБОТЫ 
В ходе данной работы студенты научатся работать с географически привязанной ин-

формацией и получат навыки создания двумерной визуализации данных с использованием 
ГИС. 

 
Добавление тайловых карт. 
В сети Интернет существует множество источников карт, которые также могут быть 

добавлены в QGIS. Посмотрим, как осуществляется импортирование не встроенных по умол-
чанию тайловых карт на примере сервиса Mapbox  (https://www.mapbox.com/). 

Для начала создайте там бесплатный аккаунт и получите ключ (token key – доступен в 
профиле пользователя). Подготовьте файл для импорта данных, с этой целью в любом тексто-
вом редакторе создайте текстовый файл типа Tabbed Separated Values (*.tsv) и сохраните его в  
локальной директории. Данный файл должен содержать следующую строку: Mapbox Mapbox 

http://api.tiles.mapbox.com/v4/mapbox.light/{z}/{x}/{y}.png?access_token=<your access 
token> 

 
Обратите внимание! Необходимо убедиться, что все слова разделены с помощью сим-

вола табуляции. Прямое копирование строки приведет к неверному результату. Также необ-
ходимо заменить фразу в угловых скобках на ваш ключ. 

Сохраните и закройте файл. Приведенная выше ссылка позволит загрузить определен-
ную подложку. Изучите сайт компании, чтобы узнать, какие еще карты доступны. Для добав-
ления карт в QGIS Desktop понадобится расширение TileLayer, установите его с помощью  
менеджера плагинов. После установки плагин будет доступен через меню Web → 
TileLayerPlugin → Add Tile Layer…  

Перейдите в окно свойств (Settings) и укажите путь к папке, в которой хранится подго-
товленный файл TSV. Выберите ваш слой Mapbox и нажмите кнопку «Add» (добавить). 

Подготовка данных с помощью BBBike.  
Для выгрузки данных с  использованием сервиса BBBike (рис. 3.3) необходимо выпол-

нить следующие действия: 
1 Переместить карту к интересуемой локации. 
2 Создать ограничительный полигон. 
3 Изменить или переместить полигон, если необходимо. 
4 Установить формат экспорта Shapefile (Esri). 



5 Нажать на кнопку экспорта «Extract». 
6 Скачать готовые данные на компьютер. 
 
Гексагональная сетка.  
Добавьте в проект данные о точках интереса (слой point), выберите из них только дан-

ные, относящиеся к кафе (type = ‘café’). Для построения сеток понадобится плагин MMQGIS, 
в  случае отсутствия установите его. Создайте слой сетки Hexagon Grid Layer, используя меню 
Create. Убедитесь, что проекции сетки и исходных данных  о галереях совпадают, в против-
ном случае создайте слой вновь. Теперь подсчитайте, сколько точек попадает в полигон, для 
этого  воспользуйтесь инструментом анализа векторных данных: Vector → Analysis Tool → 
Points in polygon (либо Processing Toolbox → Vector Analysis Tool и вызовите двойным кликом 
функцию Count points in polygon).  Отфильтруйте полигоны, которые не содержат точек, с по-
мощью инструмента Select features, условие NUMPOINTS > 0 Теперь сохраните  выделенные 
полигоны на новый слой. Настройте стили для слоя с полигонами. 

 
Тепловые карты. 
Изучим плотность застройки в Магнитогорске. Для этого откройте в QGIS слой 

buildings и извлеките центроиды из каждого полигона с помощью команды Polygon centroids в 
меню Toolbox. После этого перейдите в меню Raster → Heatmap → Heatmap.  

В окне стилей установите тип рендеринга на Singleband pseudocolor  и выберите палит-
ру. Для получения результата, установите способ классификации Quantile, а в качестве режи-
ма смешивания Burn (в дополнение к этому можно варьировать настройки прозрачности – 
Transperency). 

Другой способ создать теплокарту – это использовать сетку  регулярных точек. Убеди-
тесь, что проекция проекта совпадает с проекцией  слоя с домиками. После этого вызовите в 
меню функцию создания регулярной сетки аналогично предыдущему пункту (либо исполь-
зуйте  Vector -> Research Tools -> Regular points). 

 
Диаграмма Вороного.  
Изучим плотность остановок общественного транспорта в городе. Для этого выберите 

остановки из слоя points. Для создания диаграммы выберите в основном меню пункт Vector → 
Geometry Tools → Voronoi polygons (либо MMQGIS → Create → Voronoi diagram). Для того 
чтобы изображение было более информативным, окрасьте  полигоны в зависимости от их 
площади (установите в поле Column значение Geometry → $area, 

 
ВОПРОСЫ ДЛЯ ПОДГОТОВКИ 
1 Является ли визуализация необходимым  атрибутом картографического изображе-

ния? 
2 Какими преимуществами обладают электронные атласы в сравнении с бумажными 

картами? 
3 Не заменят ли (в перспективе полностью) бумажные атласы их электронные анало-

ги? 
4 Какие способы районирования пространства использовались в данной работе? Какой 

способ вы считаете наиболее эффективным? 
 
 

 
Лабораторная работа № 4 

Создание векторных данных в QGIS Desktop 
 
ЦЕЛЬ РАБОТЫ 
В ходе данной работы студенты получат знания о необходимых  исходных данных для 

получения географически привязанной информации, научатся производить обработку и пре-
образование данных в ГИС. 

 
Добавление данных. 



В качестве источника для создания  векторных данных можно использовать уже  су-
ществующие карты, спутниковые снимки, аэрофотоснимки, а также схемы и чертежи. Однако 
в рамках данной работы будет использован проект плана строительства, а также спутниковые 
снимки, предоставленные сервисом Google. Подгрузите  в  проект пример очереди строитель-
ства – 2- stage.geojson.  

Исходные данные являются неполными, часть зданий представлена только в виде изо-
бражения без географических координат. Исправить это можно при помощи функции привяз-
ки растра (Raster -> Georeferencer). В окне добавления растра откройте изображение 2-
stage.png  Выберите ту же проекцию, что указана в проекте и запомните ее. С помощью инст-
румента Add Point добавьте точки привязки (их можно указать на карте), 

После этого вызовите окно сохранения (Start Georeferencing) и укажите название фай-
ла, папку и соответствующую систему координат. Вызовите эту команду еще раз – в папке 
должен 

Появиться соответствующий tif-файл, содержащий информацию о координатах. До-
бавьте получившийся файл в проект (рисунок 4.1).  

 
Создание нового слоя.  
Для создания нового набора данных необходимо задать слой, в который будут сохра-

няться созданные элементы. С этой целью создайте векторный слой с помощью окна New 
Vector Layer ; для того чтобы перейти в данное окно, воспользуйтесь меню Layer → New → 
New Shapefile Layer. На данном этапе необходимо определить тип создаваемых данных: точ-
ки, линии или полигоны, поскольку каждый тип задается определенным образом и поменять 
тип данных для этого слоя в дальнейшем будет нельзя. В рамках лабораторной работы № 4 мы 
будем работать с полигонами, поэтому в окне создания слоя укажите тип полигон.  Далее сле-
дует определить систему координат. По умолчанию QGIS Desktop использует ту же систему 
координат, что у всего проекта, поэтому  данное значение можно оставить. В области списка 
атрибутов можно добавить необходимые поля для нового набора данных. По умолчанию  ка-
ждый набор данных должен состоять из элементов, обладающих уникальным идентификато-
ром – поле «id».  

 
Добавление данных. 
В качестве источника для создания векторных данных можно использовать уже  суще-

ствующие карты, спутниковые снимки, аэрофотоснимки, а также схемы и чертежи. В данной  
работе будут использоваться спутниковые снимки, предоставленные сервисом Google. До-
бавьте растровый слой с картой, используя плагин  OpenLayers.  Для создания новых вектор-
ных элементов необходимо перейти в режим редактирования данных. Режим редактирования 
включается и выключается для каждого слоя отдельно. Выделите слой на панели слоев,  кото-
рый необходимо отредактировать, и включите кнопку редактирования «Toggle Editing». 

 
Редактирование существующих объектов.  
Для редактирования  ранее созданных элементов выберите инструмент Select Single 

Feature,  
Для редактирования элементов доступны следующие инструменты: 
— Перемещение объектов; 
— Инструмент вершин; 
— Удаление выделенного; 
— элемент меню Edit → Undo либо комбинация клавиш Ctrl+Z для отмены последнего 

действия. 
Если у полигона вырезаны некоторые части, дополнить его можно с  помощью инст-

румента изменения формы (Reshape Features). Изучите  принципы работы данного инструмен-
та на примере любого района.  Кликните левой кнопкой мыши внутри области выделенного 
полигона, для того чтобы начать редактирование. Нарисуйте полигон, содержащий три угла, 
так (в форме буквы П), чтобы последняя точка  находилась внутри полигона. Кликните правой 
кнопкой мыши для завершения построений.  Используя тот же инструмент, можно вырезать 
части полигона. Для  этого начните построение фигуры снаружи редактируемого полигона, 



нарисуйте фигуру, которую хотите вырезать. Затем щелкните правой кнопкой вне редакти-
руемого полигона для завершения.  

Для того чтобы разделить один полигон на несколько частей, используется инструмент 
разделения (Split Features), чтобы отделить часть в отдельный полигон, сохранив всю инфор-
мацию. Воспользуйтесь данным инструментом для разделения рек. Нажмите левой кнопкой 
мыши существующую  вершину, затем кликните на вершину на противоположной стороне, 
полигон будет разрезан по получившейся прямой.  Воспользуйтесь инструментом выделения, 
для того чтобы  убедиться, что новый полигон создан.  

 
 
ВОПРОСЫ ДЛЯ ПОДГОТОВКИ 
1 Для чего нужны преобразования между типами данных? 
2 Почему после растрово-векторного необходимо проверять получившееся изображе-

ние? 
3 Какой тип преобразования осуществлялся в этой работе? А в предыдущей? 
4 Какие операции над векторными данными использовались в рамках данной работы? 
 

 
Лабораторная работа № 5 

Базовые операции над векторными слоями 
 
ЦЕЛЬ РАБОТЫ 
В ходе данной работы студенты получат навыки работы с программным обеспечением для 

визуализации географически привязанной информации; навыки работы со слоями электронных 
карт, освоят способы получения,  обработки  географически привязанной информации, представ-
ленной в векторном виде. Для выполнения данной работы распакуйте архив и запустите файл 
проекта. 

 
Обрезка.  
Удаление части данных с использованием границ другого слоя. Для выполнения этой 

операции перейдите в меню Vector и  выберите функцию Clip. В качестве исходного выбира-
ется слой, который необходимо отредактировать (Rivers and Streams), в качестве границ ис-
пользуется слой с границами города (City Limits). Определите адрес директории, в которой 
хотите сохранить файл, и задайте его название (например, CS Rivers.shp).  Поставьте галочку 
напротив пункта Open output file after running algorithm (таким образом, после вычислений 
слой  добавится в проект автоматически) и запустите процесс. 

Обрезка с вычитанием.  
 
Удаление данных внутри некоторой области.  
Аналогично предыдущему пункту перейдите в меню обработки векторных данных 

(Geoprocessing Tools) и выберите инструмент Difference. В качестве входных данных исполь-
зуйте слой с границами страны (Brazos County Boundary), а в качестве границ, по которым 
следует обрезать, выберите слой, отвечающий за город (City Limits). Определите папку и на-
звание результирующего файла. По завершении процесса  исследуйте результат.  

 
Пространственное  объединение. 
Аналогично базам данных различные пространственные слои можно объединять, ос-

новываясь на географическом положении. Используйте меню для доступа к функциям редак-
тирования данных Data Management Tools, в перечне  выберите объединение по местоположе-
нию (Join attributes by location).  В качестве целевого используется слой, в который необходи-
мо добавить данные (Rivers and Streams), источником данных выступает слой,  откуда 

Будет добавлена информация (City_Limits). Все  остальные настройки сохраняются по 
умолчанию. Добавьте полученный слой в проект. Для нового слоя в таблице атрибутов будут 
объединены свойства  обоих слоев. Самостоятельно изучите, в чем состоит различие между 
разными типами объединений – пересечение, касание и т.д. (intersection, crosses). 

Добавление геометрической информации в таблицу атрибутов. 



В процессе работы иногда необходимо изменить систему координат и проекций, при 
этом, как известно из лабораторной работы № 2, в зависимости от типа проекции некоторые 
геометрические свойства, такие как длина или площадь, могут не сохраниться. По этой при-
чине  целесообразно хранить эти значения вместе с остальной информацией. Для добавления 
информации выделите слой с реками (Rivers and Streams) в панели слоев. Воспользуйтесь ме-
ню управления векторными данными, перейдите во вкладку Geometry Tools и выберите инст-
румент Export/Add geometry columns. Выберите слой рек и установите параметр  Calculate 
using = Layer CRS (вычисления будут выполнены для текущей системы координат проекта). 
По завершении вычислений в таблице атрибутов добавится новое поле, соответствующее 
длине линий, LENGTH. 

 
ВОПРОСЫ ДЛЯ ПОДГОТОВКИ 
1 Какие операции над векторными данными вы знаете? 
2 Какие преобразования выполнялись в рамках данной лабораторной работы? А в рам-

ках работы № 4? 
3 Можно ли выполнять подобные операции над растровыми данными? Если да, то ка-

ким образом? 
Лабораторная работа №6 

Создание трехмерных карт 
 
ЦЕЛЬ РАБОТЫ 
В ходе данной работе студенты получат навыки работы с программным обеспечением 

для визуализации географически привязанной информации; навыками работы с видами слоёв 
электронных карт, узнают способы получения, обработки географически привязанной инфор-
мации, представленной в векторном виде. 

 
Получение данных о рельефе.  
Одним из источников данных о рельефе является ресурс USGS EarthExplorer (рисунок 

6.1), который  предоставляет информацию для исследований бесплатно. В случае если у вас 
нет аккаунта на данном ресурсе – зарегистрируйтесь.  Для получения DEM файла перейдите 
на сайт EarthExplorer  (http://earthexplorer.usgs.gov) и выберите интересующую вас область. 
Для отображения данного формата через QGIS Desktop понадобится плагин QGIS2Threejs. 
Установите его, если необходимо. 

 
Создание трехмерной визуализации. 
Откройте QGIS и  импортируйте ваш DEM файл. Как известно, файлы данного форма-

та содержат геопривязку, тем не менее добавление слоя с картой упростит работу с проектом. 
Запустите плагин QGIS2threejs. Убедитесь, что во вкладке DEM в качестве источника данных 
указан ваш файл с рельефом, в качестве отображаемого слоя (параметр – Display type) укажи-
те слой со спутниковой картой. Запустите процесс создания карты по кнопке «Run», после 
этого откроется браузер с изображением. 

 
Отображение данных в трехмерном виде.  
QGIS2threejs позволяет не только создавать карты рельефа, но и отображать данные в 

трехмерном  виде. Добавьте набор данных в проект (например, из открытых источников, либо 
из предыдущих лабораторных работ). Для настройки отображения внешнего вида перейдите 
во вкладку Point (или Polygons в случае полигональных данных). Установите значение “base 
height” – 0 Базовая высота соответствует величине отклонения объектов от трехмерной карты. 

Запустите трехмерную визуализацию. Повторите данную операцию для линейных и 
полигональных данных. 

 
 
ВОПРОСЫ ДЛЯ ПОДГОТОВКИ 
1 Что такое DEM формат? Что будет если открыть файл такого  формата в графиче-

ском редакторе? 
2 В чем преимущества и недостатки трехмерной визуализации данных? 



3 В каких случаях использование трехмерной визуализации является целесообразным? 
Приведите не менее трех примеров. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Приложение 2 

Оценочные средства для проведения промежуточной аттестации 
а) Планируемые результаты обучения и оценочные средства для проведения промежуточной аттестации: 

Код индикатора  Индикатор достижения компетенции  Оценочные средства 

ПК-6: Владеет способами разработки процедур интеграции программных модулей, компонент и верификации выпусков программного про-
дукта, включая базы данных для мобильных устройств 

Перечень теоретических вопросов  
1. Что такое карта? 
2. Что изучает наука картография? 
3. Какие способы представления данных вы знаете? 
4. Что такое геоинформационная система? 
5. Для чего применяются геоинформационные системы? 
6. Что такое сервер данных? 
7. В чем особенность понятия "база географических данных" по 

сравнению с другими типами баз данных? 
8. В чем отличие баз данных ГИС от баз данных других информа-

ционных систем? 
Практические задания  
1. ГИС и дистанционное зондирование.  
2. ГИС и система глобального позиционирования (GPS)  
3. ГИС и Интернет  
4. Топографические стандарты  

ПК-6.1 Оценивает выбор программных средств для раз-
работки и верификации программных модулей 
для мобильных устройств 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Задания на решение задач из профессиональной области, комплексные 
задания  
Ваша задача разработать и представить маршрут экологической тропы. 
Прежде всего, необходимо выбрать объекты, которые Вы хотите пока-
зать в процессе экскурсии, определить начальные и конечные пункты 
маршрута. Затем следует определить порядок прохождения отобранных 
объектов.  
Необходимо разработать приложение, в котором будет содержаться не-



Код индикатора  Индикатор достижения компетенции  Оценочные средства 

обходимая информация об объектах экскурсии, описание маршрута и 
его схематическое изображение.  
 
Примечание.  
Экологическая тропа – это специально оборудованный маршрут, прохо-
дящий через различные экологические системы и другие природные 
объекты, архитектурные памятники, имеющие эстетическую, природо-
охранную и историческую ценность, на котором идущие (гуляющие, 
туристы и т. п.) получают устную (с помощью экскурсовода) или пись-
менную (стенды, аншлаги и т. п.) информацию об этих объектах. 
1.  Для создания такого типа познавательных троп существует ряд важ-
нейших исходных положений. Наиболее целесообразно прокладывать 
подобные тропы вблизи интенсивно посещаемых рекреационных рай-
онов. 
2.  К тому же тропа должна быть доступна в транспортном отношении. 
Желательно, чтобы район тропы хорошо посещался местным населени-
ем. Маршрут лучше всего прокладывать по уже сложившейся дорожке – 
тропиночной сети. При его выборе важно учитывать привлекательность 
окружающего ландшафта. Следует избегать участков с монотонными 
од- 
нотипными природными сообществами. Необходимо чередование от-
крытых пространств с лесными тропинками, уголков нетронутой приро-
ды с участками, которые подверглись значительному антропогенному 
воздействию. 
3. Наряду с привлекательностью, другим важнейшим качеством тропы 
является ее информативность. Получаемую здесь информацию условно 
можно разделить на познавательную «просветительную» и предписы-
вающую. Каждому виду информации соответствуют 
«свои» объекты на маршруте и свои знаки – символы (напоминающие 
дорожные знаки). 



Код индикатора  Индикатор достижения компетенции  Оценочные средства 

4. Специфические экскурсионные объекты на тропе – памятники приро-
ды, например, вековые деревья, которые являются свидетелями событий 
далекого прошлого. Рядом – элементы антропогенного ландшафта, это 
могут быть транспортные магистрали (дороги, линии электропередач), 
архитектурные сооружения, водоисточники, заповедные территории, 
сама 
зона рекреации, как один из видов природопользования. 
5. Все интересные объекты природы и истории обозначаются распола-
гающимися рядом табличками – указателями; цифрами или символами. 
А информационные щиты, устанавливаемые через определенные рас-
стояния и у особо интересных объектов, позволяют быстро получить 
соответствующую информацию и направить движение посетителей по 
заданному маршруту. 

ПК-8: Владеет навыками ввода в эксплуатацию аппаратных, программно-аппаратных и программных средств инфокоммуникационной инфра-
структуры совместно с представителями поставщиков оборудования, готов к обслуживанию периферийного оборудования и организации ин-
вентаризации технических средств 
ПК-8.1 
 
 
 
 
 
 
 
 

Оценивает качество ввода в эксплуатацию аппа-
ратных, программно-аппаратных и программных 
средств инфокоммуникационной инфраструкту-
ры. 
 
 

Перечень теоретических вопросов  
1. Приведите примеры того, каким образом может нарушиться целост-
ность базы пространственных данных без соответствующего контроля 
доступа. 
2. Как обеспечивается надежность хранения данных в БГД? 
3. Каковы пути устранения последствий ошибок в данных? 
4. Объясните разницу между точностью представления данных и точно-
стью вычисления, покажите, как эти понятия применяются в ГИС. 
5. Что подразумевается под "происхождением" данных, почему оно 
важно 
для понимания точности баз пространственных данных? 
6. Каковы преимущества создания объектно-ориентированных БД при 
работе с пространственными данными? 
7. В чем отличие технологий координатной регистрации и трансфор- 



Код индикатора  Индикатор достижения компетенции  Оценочные средства 

мирования цифровой карты? 
8. Как рассчитать параметры сканирования карты заданного масштаба 
для обеспечения требуемой точности цифровой карты? 
9. Каковы различия в проектировании карты и ГИС? 
10. Чем определяется необходимость и периодичность обновления про- 
странственных данных? 
11. Чем определяется выбор программного средства создания карты? 
Практические задания  
1. Стандарты атрибутивного описания электронных карт  
2. Анаморфированные изображения объектов электронных карт  
3. Пространственный анализ в реляционных базах данных  
4. Язык разметки географической информации KML  
5. Веб-ориентированные геоинформационные системы. 
Перечень теоретических вопросов  
1. Перечислите средства анализа данных в ГИС.  
2. Раскройте содержание проекционных преобразований в ГИС.  
3. Приведите основные принципы разграфки топографических карт.  
4. Охарактеризуйте основные принципы построения номенклатуры то-
пографических карт.  
5. Охарактеризуйте основные принципы построения триангуляционной 
модели местности.  
6. Раскройте содержание технологии ведения атрибутивных данных 
ГИС.  
7. Охарактеризуйте основные этапы развития ГИС. 

ПК-8.2 
 
 

Оценивает качество обслуживания периферийно-
го оборудования и организацию инвентаризации 
технических средств 

Практические задания  
1. Свойства карты как модели 
2. Графические средства изображения в картографии 
3. Локализация пространственных объектов на карте 
4. Точность нанесения пространственных объектов на карту 
5. Способы картографического изображения. 



б) Порядок проведения промежуточной аттестации, показатели и критерии 
оценивания: 

Промежуточная аттестация по дисциплине «Геоинформационные системы» 
включает теоретические вопросы, позволяющие оценить уровень усвоения обучающими-
ся знаний, и практические задания, выявляющие степень сформированности умений и 
владений, проводится в форме экзамена. 

Экзамен по данной дисциплине проводится в устной форме по экзаменационным 
билетам, каждый из которых включает 2 теоретических вопроса и одно практическое за-
дание.  

Показатели и критерии оценивания экзамена: 
– на оценку «отлично» (5 баллов) – обучающийся демонстрирует высокий уровень 

сформированности компетенций, всестороннее, систематическое и глубокое знание учеб-
ного материала, свободно выполняет практические задания, свободно оперирует знания-
ми, умениями, применяет их в ситуациях повышенной сложности.  

– на оценку «хорошо» (4 балла) – обучающийся демонстрирует средний уровень 
сформированности компетенций: основные знания, умения освоены, но допускаются не-
значительные ошибки, неточности, затруднения при аналитических операциях, переносе 
знаний и умений на новые, нестандартные ситуации. 

– на оценку «удовлетворительно» (3 балла) – обучающийся демонстрирует поро-
говый уровень сформированности компетенций: в ходе контрольных мероприятий допус-
каются ошибки, проявляется отсутствие отдельных знаний, умений, навыков, обучаю-
щийся испытывает значительные затруднения при оперировании знаниями и умениями 
при их переносе на новые ситуации. 

– на оценку «неудовлетворительно» (2 балла) – обучающийся демонстрирует зна-
ния не более 20% теоретического материала, допускает существенные ошибки, не может 
показать интеллектуальные навыки решения простых задач. 

– на оценку «неудовлетворительно» (1 балл) – обучающийся не может показать 
знания на уровне воспроизведения и объяснения информации, не может показать интел-
лектуальные навыки решения простых задач. 


